
Anchor Cursor

By setting this to yes the standard Windows arrow cursor will change

to pointing finger cursor whenever the cursor moves over link

anchor Isnt the little hand cute Well its functional anyway

Note Anchor Colors are called Hotlinks in Mosaic for Mac and Win
dows On all platforms they are also referred to frequently as hyperlinks

Show URLs
If turned on URL addresses will appear in the Status bar assuming

you have that set to yes whenever the cursor moves over link anchor

Extended FTP
When you encounter an FTP or Gopher site in Mosaic you have op
tions as to what you see If set to yes the site displays icons relevant to

the type of file being viewed If the size of the file has been specified

you will see that too If this option is set to no you see only list of

directories and files with no icons and no file size indications

Toolbar

The toolbar that runs along the top of the main Mosaic window is one

of the most important navigation tools in the program If you want the

displaying of the toolbar to be defaulted set this to yes

Status bar
The Status bar located in the lower left-hand corner of the main Mosaic

window gives you valuable feedback as to what Mosaic is up to at any

given time during file access and transfer Vote yes if you want this

bar to always appear unless you toggle it off in the Options menu
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Figure 3-19 More of the mosuic.inifile

Title URL bar
This option set to yes will display the URL bar and Status Indicator

NCSA logo at the top of the document view window

Use 8-bit Sound

With this checked all sound files that you transfer in

Mosaic will be handled by an 8-bit sound card This is

useful if you dont have 16-bit card installed

Here is where you specify what color you want Mosaic

link anchors to be The default color is blue 00255 The

color values are expressed as numbers with zero being no

instance of the color and 255 being full strength The color

value sequence is red green blue If you wanted to

change the anchor color to red you would change the

setting here to 25500 Green would be 02550 and so forth

Windowl

The Main Window refers to the size of the main Mosaic window and its

position on your monitor Do not edit this directly in the mosaic.ini file

To change the screen size and location

From within Mosaic resize the main window to your desired con

figuration and move it on the screen where you want it to appear each

time its launched

Choose Save Preferences from the File menu and the window size

and position will be written to the mosaic.ini file

Nocpad MOSAICINI

Tool baryes
Statos bar5e5
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width7O3
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Note If you have made any other changes in preferences from within

Mosaic such as Display Inline Images Show Status Bar Show URLs etc
these changes will also be saved to the mosaic.inifile and will become the

default preferences If you do not want this to happen make sure you only

change the window size/position before selecting the Save Preferences option

When you choose Mail to Developers in the Help menu from within

Mosaic what you have entered here will always appear as the default

title of your message You can of course change that title for each instance

to reflect the current subject of the message The mail title comes

defaulted to WinMosaic auto-mail feedback If you want it defaulted

to something else say Fanmail from Some Flounder or HELP
you can make those changes here Your return email address also needs

to be entered in the appropriate line above in the section if you

want NCSA to be able to respond to your question Also if you have

local SMTP server at your Internet service providers site for instance

make sure that is changed in the section below

To be able to read USENET Newsgroups from within Mosaic and to get

responses to email messages sent to NCSA you need this section to be

properly filled out

NNTP Server The NNTP Network News Transport Protocol

server should equal your network service providers NNTP
Mosaic comes defaulted to the University of Illinoiss NNTP
server news.cso.uiuc.edu This will work fine as newsgroup

gateway but to save traffic to this site if you have local NNTP
server enter it here It will usually be in the form of

news.site.domain This information should have come with

your SLIP/PPP account
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Note On some Internet service providers set-up information sheets this

address is also called an NNRP instead of NNTP This probably stands for

Network News Reader Protocol

SMTP Server The address for the SMTP Simple Mail Trans

port Protocol server should be your local services SMTP
Mosaic comes defaulted to the NCSAs NNTP server

ftp.ncsa.uiuc.edu This will work as mail gateway but to

save traffic to this site if you have local SMTP server enter it

here This information should have also come with your SLIP
PPP account

_____________________________________________

Viewers or Helper Applications are external programs
that Mosaic uses to access media files sounds graphics

movies on the Web It is in this section of the mosaic.ini

file where you can map Helper Application types to

specific applications and then define the local hard drive

directory path to those applications That way when
Mosaic encounters file of that media type it will transfer

the file hold it temporarily and then launch the external

application to show or play the media file in question See

Configuring Helper Applications below for more

detailed instructions on using these external applications

with Mosaic

Figure 3-20 The Viewers section of the mosaic.ini file
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Suffixes refer to the file extensions that Mosaic looks for in accessed

media files These suffixes only come into play on FTP sites and Web

sites using HTTP version 0.9 These 0.9 sites are very rare and you will

probably not encounter them HTTP version 1.0 does not use these

suffixes because the file is typed by the server and not your Mosaic

client For each file type you can list as many different versions of the

extension as you think Mosaic may encounter For instance

image/jeg .jpeg.jpg.jpe

video /quicktime.mov.moov and so forth

Make sure that the extension list is separated by commas no space

and that each extension begins with period

In Mosaic 2.x annotations can be personal or shared over workgroup
Your personal annotations are stored within file on your PC while

group annotations are stored on local networked machine Here is

where you define the storage location for personal and group annota

tions

Directoryc\mosaic\annotate or whatever the directory path
is on your machine

Default TitlePersonal Annotation by Mosaic User If you want

different title to appear when your choose an annotation enter

it here The obvious choice would be to replace Mosaic User

with your name

Group Annotations If you are planning on sharing annotations

over network set this to yes Otherwise leave it defaulted to

no You can also toggle this on and off by checking Show Group
Annotations under the Options menu
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Group Annotation Server your.local.lan.serverportNumber To

share annotations over local network you need to specify the

machine on the network and the port number where the

group annotations will be stored Check with your LAN admin

istrator for more information

Menu
This section of the mosaic.ini file shows you the structure and contents

of your user-configurable hotlist menus Do not change them here If

you want to create add to or change menus use the Menu Editor

found under Navigate within Mosaic See Creating Custom Hotlist

Menus below for more information

This section is list of URLs that are contained in the Quicklist The

Quicklist is general hotlist that comes already set up with Mosaic

Using the Menu Editor you can add and subtract to this list as you

please The Quicklist is the only hotlist that is not part of the Starting

Points pull-down menu You access Quicklist via the Open URL win
dow To edit the Quicklist or any hotlist use the Menu Editor Do not

however change anything in this area of the mosaic.ini file

Caching

TypeNumber
Number

Document Caching refers to how many documents Mosaic will store

Each time you load Web document to your screen that document will

go into the cache up to the number you specify here If you then

return to one of the documents thats been cached Mosaic doesnt need

to reload it from its server So as you might imagine the best thing to

do is to select high number to save time and unnecessary Net traffic
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How many documents you specify is function of how much memory

your PC has If you have large amount of RAM select higher

number if youre low on RAM select only few cached

documents If youre really pushing your available .-
memory set this number to zero no caching You can What in Blue Blazes Is Firewall

experiment to find number thats appropriate good firewall is server computer that is set up
number to start with is between the users of local area network or

LAN and their gateway to the Internet As
sections

you might imagine because the Internet is

Again this area of the mosaic.ini file is not to be changed public its not very secure Every computer on

All changes to fonts and font styles are done in the Choose the Internet is considered peer
of every

Font choice under the Options menu other computer computer attached to

LAN that is routed to the Internet is potentially

Information accessible to anyone on the Net firewall

Your copy of the mosaic.ini file may include section on processes network input and output and

Proxy Firewall services or section can be added if allows the computers on LAN to pretend

appropriate proxy service processes
network input and that theyre actually on the Net when they

output to and from computers on local area network technically arent The problem with this

LAN that sits behind firewall computer security
scheme is that it sometimes hinders the perfor

barrier that prevents unwanted intrusions By gatewaying
mance of programs that want to be directly

through proxy service the LAN can pretend that its
Net-connected Mosaic is such program

actually on the Net when tecimically it isnt its being
The CERN Proxy/SOCKS services now

mediated through the proxy For full details on using
available with Mosaic 2.x help improve

proxy service with Mosaic check out the document at gateway performance for systems that are

http//www.ncsa.uiuc.edu/SDG/Software/WinMosaic/
hiding behind firewalls

Proxylnfo.html
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Configuring Helper Applications

Helper Applications are external programs that Mosaic uses to help it

display various media files This scheme allows Mosaic to keep its

mind on its business while letting other sophisticated viewing and

listening applications handle the media presentations This also gives

Mosaic great degree of flexibility allowing you to add new types of

Helper Applications as you need them

The first thing you need to do is check to see which of the Helper

Applications you have and which youll need Table 3-2 shows you the

main default applications Mosaic uses

Default Application Special Requirements iype

GIF/JPEG images LView SVGA Monitor Freeware

QuickTime movies Movie Player QuickTime For Windows Freeware

MPEG movies MPEGPLAY 8mb Ram Recommended Shareware

AU sounds WHAM w/sound card Sound Card Donationware

AU sounds WPIany w/o sound card PC Speaker Driver speak.exe Freeware

Zip compressed files PKUNZIP None Shareware

All of these programs are freeware or shareware and are available via

anonymous FTP from many of the FTP sites listed elsewhere in this

book See Table 2-2 in Chapter for FTP site listings

Payment

Table 3-2 The default Helper Applications
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Before youve downloaded the Helper Applications you need you
should create home directory for them If youre truly lazy you can

look at each Helper Application in the mosaic.ini file and find out what

the defaulted pathname is creating the appropriate directories to

conform to those paths This way you wont have to change any

filepaths in the mosaic.ini file more sensible approach would be

On your hard drive create directory called apps or whatever you
wish to call it Mine is c\windows\apps

Within the new apps directory create new subdirectory for each

application \windows\ apps\mpegplay \windows\apps\lview

\windows\apps\wplany etc.

Download or move within your hard drive the zipped Helper

Application files into their respective subdirectories See Chapter for

information on FTPing files

Unzip the files in their respective subdirectories

Read each apps installation instructions registrations and readme files

Open up the mosaic.ini file using the Windows Notepad Within the

section of the mosaic.ini file find the pathname for each

Helper Application Change the path to reflect its location on your
drive In our example we would make sure that each path read

\windows apps \helper_app_name.%ls

Save the mosaic.ini file

That should be all there is to it assuming youve followed any
instructions that came with the application Now when you encounter

media file during Mosaic session and download it Mosaic will

access the appropriate helper and use it to open the file When done

viewing or listening you can quit the Helper Application which is

now on top of Mosaic or you can save the file to disk if that option is

available
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Figure 3-21 Changing Helper Application

inage/gifc\windows\apps\lview\luiewal %ls
inaqe/jpeqcphotoshpphotoshp

1s

Figure 3-22 The new Helper Application for JPEG

images

If you wish to change any of the Helper Applications or add new

applications youll need to go back in the mosaic.ini file

For example lets say you want to change an application Mosaic is

defaulted to access LView as the application for displaying jpeg images
If you didnt have LView but have another graphics application such

as Photoshop heres how you would configure Mosaic to use the new

application

First determine the filepath of the new application In this case its

c\photoshp\photoshp.exe or whatever the pathname might be
Open up the mosaic.ini file using Notepad and find the image/jpeg

application line

Change the current jpeg statement to equal the pathname of your new

application in this case image/jpeg c\photoshp\photoshp %ls
Notice that the extension .exe was dropped and the argument %ls was
added

Note Notice the forward slashes used in MIME typing as opposed to the

DOS backslashes Be careful when editing Helper Applications that you

slashforward and back at the right time It can get confusing

Save the changes to the mosaic.ini file

Launch Mosaic and retrieve copy of whatever file will

require that Helper Application type for our example we
would want to find jpeg image to view

If your test is unsuccessful go back to the mosaic.ini file

and make sure you have the pathname correct Also look

in the top section of in the part that has Type
to make sure that the application youre attempting to

map has MIME type listed more on MIME types

below

inaqe/gifc uindows\apps\1uiew1uiew31 1s
inage/jpegc \uindows\apps1uiew\1uiw31 t1s
uideo/mpegc\win32app\mpeqp1anpegp1ay 41s
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Mapping New File Types

The other main feature of the section of the mosaic.ini file is

the ability to add new types of files and to map them to applications

found on your hard drive The first part of the section is

listing of many of the MIME file types that Mosaic recognizes MIME

or Multi-purpose Internet Mail Extensions is standard originally

developed for attaching media messages to conventional Internet

email Mosaic has adopted this standard and uses MIME file types for

specifying its external Helper Applications Table 3-3 shows the common
file types that Mosaic recognizes and the defaulted applications if any

File Type uwype Application

Text plain text Notepad
richtext MS Write

html Mosaic

Audio basic Mosaic

way WHAM
way Media Player

x-midi Media Player

Images jpeg LView

gif LView

tiff no default application

x-xbm no default application

Video mpeg MPEGPLAY

quicktime Movie Player

msvideo Media Player

Applications postscript Ghostview

zip UnZip

Table 33 Common flits ti/pec and 1icper App//Lilt ions in Mosaic
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The first time you launch Mosaic you automatically go the Mosaic

Home Page at NCSA Due to the current popularity of Mosaic
traffic to the NCSA server is high You can ease this burden on the

electronic highways by making another Web location the default

home page Simply change the Home Pagez line in the mosaic.ini

file suggest you choose Ventanas Visitors Center at http//

www.vmedia.com/vvc as your new Home Page That way you
can keep up with the latest news about Mosaic and the Web this

book and the newest releases of all the freeware and shareware

covered here Once youve entered the new Home Page URL save

the changes to the mosaic.ini file and relaunch Mosaic
SW

Using Styles in Mosaic

The Choose Font feature found under the Options menu allows you
to customize the look of the Web documents you view The documents

you view in Mosaic are created using HTML tags sometimes called

style tags These are bracketed codes that tell Mosaic how to display

the various parts of document The information thats communicated

over the Web does not specify the actual font it simply tells Mosaic

what style category to present things as normal paragraph top level

header quotation etc. You get to choose the actual font and style in

which the document will appear Heres where you get to be little

creativechanging styles and font sizes to suit your fancy See Table

3-4 for list of the different parts of an HTML document and what

changing them will affect
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Style Type What It Modifies

Normal The default paragraph style

Header Topmost heading

Header Second level heading
Header Third level heading
Header Fourth level heading
Header Fifth level heading

Header Sixth level heading
Header Seventh level heading
Menu List in menu form

Directory List in directory form

Address How the authors name and email address will

appear at the bottom of documents

Blockquote Extended or block quotations

Example Short samples of code

Preformatted Text already formatted in monospaced font e.g
program listings

Listing Long instances of code samples

Table 34 Paragraph sti/e tag that can be mod ficd in Mosaic

To change any of the default type styles in Mosaic

Pull down the Options menu and click on Choose Font submenu
will appear See Figure 3-23

Select the paragraph style you want to change see Table 3-4 if you
are unsure what some of these styles represent

Font selection window will pop up offering you list of the fonts

in your system to choose from font style regulai italic bold bold

italic and list of font sizes
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Headerl
Header
Header
Headerg

Header
Header
Headerl
Me flu

Directory

Address

IIock Quote

xampIe
Pretormatted

Listing

When you are happy with your selection click on the

OK button

You should see your changes in the current Web docu
ment you are viewing These changes do not just affect

this document but all future documents until you change
the Font settings again

Lets try few more examples to make this clearer

If you want all information thats been tagged within an

HTML document as the style Blockquote to always appear
in boldface 24-point Times you would select Blockquote

in the Choose Font menu and make those selections in the

Font window From then on whenever document

appears that includes blockquotes it will appear on your
Web document as boldface 24-point Times

Keep in mind that these changes will only effect styles

that have been appropriately tagged by the documents

creator If an HTML document creator decides not to tag

an address with the HTML tags that specify an address

your choosing special font or style for addresses will

have no effect on that particular document It should also

be clear that the changes you make do not affect that

actual HTML documentjust the way your copy of

Mosaic presents it to you

i2ebuin into

Choose Font Normal

Choose the combination you want remember you are just changing
the part of the paragraph you selected in step not the entire docu

ment The Sample box displays the characteristics font

style size of your choice

Figure 3-23 The Choose Font. menu

Figure 3-24 The Font window
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Using Forms

The introduction and increasing sophistication of forms in

HTML documents is one of the things that has excited

people so much about the growth of Mosaic Before forms

the World Wide Web was only document viewing envi

ronment The ability to enter information into boxes on

Web page makes the World Wide Web now two-way

means of communication Some of the ways that forms

can be used are outlined in Table 3-5

If you are interested in learning more about forms and

how to create forms using HTML check out the Web

document located at http//south.ncsa.uiuc.edu/forms.html

How to Use Hotlists

Figure 3-25 typical form in Web document

There are so many great resources to discover in the Web In an average

Mosaic session you can open up oodles of documents explore dozens

of hyperlinks and generally tangle yourself up into knots One of the

most useful features of Mosaic is Hotlists the feature that enables you

to create multiple address books of documents youve visited that

you might want to return to You can save these lists under different

names and even exchange lists with other Mosaic users

Creating Your First Hoilist

The easiest way to get started with hotlists is to use the Quicklist that

comes already set up in Mosaic Although this list already contains

some URLs you can delete them if you like or just start adding to this

list using it as your current hotlist To do this

Select the Open URL item from the File menu

When the Open URL window pops up choose the Quicklist from

among the lists offered under the Current Hotlist box

Godzlllas Pizza-- Internet Deliveiy Service

Type in your street address I________________

Type in
your phone number

Which toppings would you like

111 Pepperoni

lilSausage

P1 Anchovies

To order
your pizza press

this button

68 MosAic QUICK TOUR

Petitioner Microsoft Corporation, Ex. 1005, p. 68



Form Type Jsage

Ordering Commerce on the Net Allows Net-based shop

pers to select items from online catalogs Credit

card information can also be taken and is

becoming increasingly secure thanks to digital

signature and encryption technology

Survey Web users are now able to

fi
ll out all types of

information for commercial government and

private purposes

Database The ability to handle multiple forms and check

boxes allows for even greater levels of sophisti

cation and flexibility in searching databases for

online information

Feedback Sites can now let users give direct input without

having to resort to email

Interactive Talk Form-based discussion groups similar to

USENET Newsgroups

Password Forms can be used to create private Web sites

that can only be entered with password

Gaming All variety of so-called rotisserie games base

ball footbcill and other form-based games are

possible using Mosaics form features

Free Expression
number 0f sites on the Web use forms as

way of letting people input poetry ideas graffiti

and other creative forms of expression

dIk .1 iiiii ii iI-l
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With the Quicklist visible in the Current Hotlist box choose Cancel

This Quicklist will now be considered your current hotlist

Whenever you come to Web site that you want to add to the

Quicklist choose Add Current To Hotlist from the Navigate menu Your

new Web document will appear at the bottom of the list

Creating Custom Hotlist Menus

Before we create our first hotlist menu from scratch lets

open up the Menu Editor located under the Navigate

menu The Menu Editor window will appear See Figure

3-26

The Menu Editor

You will see two fields within this window The left field

the Menus field contains list of all the user-configured

menus currently set up in Mosaic The right field contains

the items from each one of the menus as you select them in

the Menus field

Insert..

This button opens the Add Item window Here you can

enter new item into an existing menu add submenu to

an existing top-level menu or create new top-level menu
If you want to insert an item somewhere in list click

on the menu item below where you want your item in
serted If you want to add the item to the end of the exist

ing list you dont need to specify location and it will automatically

be added to the bottom of the list

Figure 3-26 The Menu Editor window

Figure 3-27 The Add Item window
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The Add Item window always opens up with the currently selected

document displayed in its Title and URL field If that is not the docu
ment you wish to add to your list you can enter in new title and

URL If you want to copy an item from another menu list go to that

item in the Menu Editor select the Copy Item button see below for

more info and then return to the Add Item menu by rechoosing Add
Item Your newly selected lists name and URL will appear in the

appropriate boxes

There are three buttons on the Add Item window

Document Item Adds title and URL to an existing menu

Menu Creates new menu with the title specified in the Title box

Separator Adds line into pull-down menu if you want the

menu to have several separated subsections

Copy Item

Clicking this button from the Menu Editor copies the document title

and URL to memory The next time you open the Add Item window
this document will appear as the selected title/URL

Delete

Removes the document or entire menu that youve selected You will

get dialogbox asking if you really want to do this Make sure you are

deleting the right thing The Quicklist menu item cannot be deleted

although items within it can

Edit..

Choosing this item causes the Edit Item window to appear From here

you can edit the name of menu and the contents of menus You

carmot rename the Quicklist It is hardwired into Mosaic You can
however edit its contents
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Now that we know what everything does lets create new hotlist

menu Since want to have series of my own hotlists easily accessible

want to create top-level menu that will appear as

pull-down menu in Mosaics main window That way
can add items and submenus as choose

Open the Menu Editor again from the Navigate menu

Highlight the empty space right above QUICKLIST in

the Menus field the left-hand field You will notice when

you do this that the right-hand field Items will display

the statement Click Insert to add toplevel menu
Click on the Insert button and the Add Item window

will appear

Since were creating top-level menu only the Title box

is available Notice also that the Menu radio button is the

only selection available Enter title for this menu My
Hotlists for instance

When youve entered the title choose OK
You will be returned to the Menu Editor where you

should see your new menu in the list of top-level menus
See Figure 3-30

From the Menu Editor you can now select your new
menu and begin adding document titles and URLs or you
can select the new menu as your Current Hotlist and then

start building the list as you travel through cyberspace

Remember you can either add documents directly to this

top-level menu or create submenus within it see below

Figure 3-28 The Edit item window

Figure 3-29 Creating hotlist menu

Figure 3-30 The new top-level hotlist menu
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Adding Submenu

Adding submenu to an existing top-level menu is easy

Go to the Menu Editor and highlight the top-level menu you wish to

add submenu to In this case want to add the submenu Art and

Design to My Hotlists

With My Hotlists highlighted click the Insert button

The Add Item window will appear Click on the Menu
radio button

Enter Art and Design or whatever you are calling your
list and choose OK

You will be returned to the Menu Editor and you should

see your new subrhenu in the Items field set off by

You can now select the Art and Design hotlist in the

Menus field to begin adding documents or you can select

the new submenu as your Current Hotlist and then start

building the list as you travel through cyberspace

Sharing Hotlists

If you want to share one or more of your lists with other Mosaic users

Close the Mosaic program and open up the mosaic.ini file

Find the list you want to send to someone Highlight the Title/URLs

of these items

Select Notepads Copy command from the Edit menu

You can now paste this list into new text document that can be sent

to another Mosaic user

Figure 3-31 The new hotlist submenu for Art and

Design
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Note Unfortunately there is currently no way of automatically exporting

or importing hotlists in Mosaic for Windows The person who receives your

list will have to cut and paste to the Menu Editor to integrate these items

Alternately lists can be easily converted to HTML documents with each

document as link anchor See Chapter 4for primer on basic HTML coding

Navigation in Mosaic

Obviously the reason youre in Mosaic is to go placesto explore that

expanding universe of hypermedia we rattled on about in Chapter
The main controls for doing this are located in the toolbar and the URL
box at the top of the Mosaic window After youve entered your desti

nation this area tells you where youre going and gives you the options

of retracing your steps or instantly returning home

The Toolbar

The toolbar is one of the most helpful features of Mosaic

It puts many of the often-used functions of the pull-down
OQ cj

easy access

Open URL/Current Hotlist
Figure 3-32 Mosaics toolbar

This is equivalent to selecting Open URL from the File

menu The Open URL window will pop up allowing you
to enter URL or to select an existing hotlist

Load to Disk

Allows you to save items to disk Equivalent to selecting Load to Disk

from the Options menu
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Back

The Back button the arrow pointing to the left takes you back through

all the documents youve accessed during your session If there are no

previous documents loaded this button will be grayed out

i- Next

Little Background on HTML HyperText The Next button the arrow pointing to the right takes

Markup Language HTML is specialized set
you forward to any documents that are ahead in the

of tags that tells Mosaic and other Web documents that have already been loaded This button is

browsers how to display the text hyperlinks only available if there are forward documents available

images and other multimedia elements you documents that youve accessed during your session but

see on your screen These tags are guidelines then moved back through in the document queue
for how browser should display the mate
rial Some tags are required by all HTML Reload

browsers while other tags are optional All
Causes the current Web page to be redrawn in the docu

Web browsers are different Some like
ment view window Some sites also use the reload com

Mosaic are graphical while others are text- mand as way of loading series of pictures Instead of
based Since HTML is only set of guidelines

going to several Web pages to view succession of images
for displaying the documents ot everyone

you stay on one page and hit Reload to see new images
has to have the same capabilities to access

Reload is also used when you make changes in or delete
Web intormation Once tne HTML aocurnent

an annotation and you want the changes to take effect
arrives at its aestination tne arowsing sari-

ware can use whatever tags are appropriate
imme iate

to it and ignore the rest Far instance Lynx
another popular Web browseç supports text

only It therefore ignores the HTML style Clicking this icon at any time during your Mosaic session

information thats not relevant to it Mosaic
takes you back to your designated home page If you have

on the other hand presents documents in all not changed your home page in the mosaic.ini file clicking

their multimedia glory and even gives you
Home takes you back to the Web server at NCSA

further display options This flexibility allows Note Back Next Reload and Home are also available under

you to change the way Web documents look
the Navigate menu They work exactly the same as their

on your system .-
toolbar equivalents
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Copy

Copies selected text You can copy text from any of the data entry

boxes URL boxes and from the Document Source window At this

time you cannot copy material from Web documents

Hopefully the NCSA developers will implement this in
For more information on how HTML works

the future the Mac version already allows it For now ii

cnec out the roitowing Web aocuments
you can use the Save As command under the File menu to .u

me r-iiiv rrimer at
save text documents to disk copy command is also

hp//w.ncsa.uiuc.edu/GeneraI/Internet/
available in the Edit menu WWW/HTMLPrimer.html and the HTML

Paste
Documentation at http//www.ucc.ie/info/

net/htmldoc.html
Pastes the contents of the Clipboard into the active pop-up
window You cannot copy things into Web documents

Find

Locates text within the currently displayed document window pops

up asking Find What Find command is also available in the Edit

menu

Print

Prints the currently selected document If you want the printing to be

the same as what you see in Mosaic you must have scalable versions of

the fonts installed on your system Check font selections and change

as needed in the Choose Font section of the Options menu print

command is also available in the File menu

About Mosaic

Displays the About Mosaic information panel
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The URL Box

In Mosaic 2.x you can enter URLs directly into the URL box Press

Enter and the connection to an HTTP server will be attempted The

URL box will always display the currently selected Web
document See below for more detailed information on

URLs

Note The other method of entering URLs is found under the

File menu as Open URL.. or ControlO

The Mosaic Status Indicator

The planet icon in the upper right-hand corner of the Main Mosaic

window is called the Status Indicator or simply the NCSA logo When
Mosaic is searching for URL or otherwise involved in data transfer

the Status Indicator becomes animated with little lights zooming
around the spinning Earth neat eh

The Status Indicator can also be used for canceling document

transfer If in the middle of download you decide that you dont
want to continue simply click on the animated Status Indicator and the

transfer will be terminated

The Status Bar Message Area

This area directly below the document view window displays mes

sages about whats happening during your session when Mosaic is

connecting to site downloading documents or having trouble with

___________ transfer These messages can be turned on or off in the

Options menu Show Status Bar See Figure 3-35

Figure 3-33 The Document URL window

Figure 3-34 The Status Indicator

Figure 3-35 The Status bar message area
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History

Next to the toolbar URL box and Status Indicator perhaps the most

important navigation feature in Mosaic is the History list

located under the Navigate menu Unfortunately there is

no icon on the toolbar and no quick key that you can use

to access History You have to go to the Navigate menu
each time you want to access it

Search

When you access an online index or document with

lookup features the Search box appears in the bottom of

the document view window directly above the Status

bar Search is different than the Find command located

under the Edit menu which only looks within the current

document for specified text matches Search looks through

an index of documents on your keywords and then

presents you with hyperlinked list of the relevant items

the search has uncovered From this list you can click on

any of the linked documents to view them See Figure 3-37

What Is URL
Uniform Resource Locator or URL is system that the

World Wide Web uses to standardize the addresses of

various types of Internet services Each type of service

HTTP HTML document transfer Gopher FTP USENET

News etc has constant type of URL address that Web browsing

software can read Although these addresses are lengthy and look

intimidating at first they become easier to read as you get more famil

iar with their structure

Figure 3-36 The History window

Figure 3-37 The Search Index box
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Anatomy of URL

URL usually consists of three parts the method of access the loca

tion of the computer where the desired files or services are available

and the path to those files

The Access Method or Protocol

This is the first part of the address usually separated from the

rest of the address by colon and double slash 1/ This tells

Mosaic what type of service it will be connecting to

Location of Computer Site

The name of the computer site where the service or file is

located usually found directly after the double slash

File Pathname

The specific name and location of the file being sought This can

be anything from the name of file directory to the full path to

the file itself Sometimes URL consists of only the first two

parts with no file specified i.e http//www.wired.com

Access Method Type of Access

http World Wide Web server file HyperText Transport

Protocol

file Files on your local system or on anonymous FTP

server

ftp Remote file transfers File Transport Protocol

gopher Connects you to Gopher server

news USENET Newsgroups reading only

Table 3-6 Common types tf LIRLs
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Reading URLs

The basic structure of URL looks like this

http//www.neowobbly.com/pub/files/codehound

Here are some examples of URLs and what they mean

http//www.wired.com

http//www.wired.com/Etext/2.O7/f eatures/patents.extras.html

The first http URL takes you to the home page of the WWW server at

wired.com an electronic magazine stand run by Wired magazine The

second URL takes you directly to an electronic text version of an article

on patents that appeared in Wired 2.07

gopher//well.com

gopher//gopher.well.sf.ca.us/OO/Publications/authors/Sterlinglfsf/

buckymania
The first URL accesses the Gopher site at the WELL BBS The second

URL goes directly to an article called Buckymania written by Bruce

Sterling This article is located in the authors section of the Publications

directory

File path name

Computer site address

Separated by only or

Access Method
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ftpdlftp.eff.org

 
   
  

ftp://ftp.eff.orglpub/EFF/about.eff
The first URL takes you to the EFF’s (Electronic Frontier Foundation)
FTP site. The second one accesses an introduction to the EFF located in

= the EFF section of the Pub directory.

news:rec.music.industrial

news:2up168$3b9@jimbo.muppet.bt.co.uk

The URL form for accessing a USENET Newsgroup

through Mosaic is different than the other forms discussed

above. Here it’s just news: (with no double slash) followed

by the name of the newsgroup. In this example, we have

accessed the industrial music group found within the rec

(recreation) category of newsgroups. The second example

shows the full path name to an article located in

rec.music.industrial. To find out more about using Mosaic

to read newsgroups (and alternative newsreaders), see

Chapter 4, "Web Walking With Mosaic.”

Moving On
If you’ve read through this chapter, congratulations! You

now know most of what you’ll need to be a Web walker

extraordinaire. You at least know your way around all of

Mosaic’s most commonly used features. These are the

tools you’ll need to venture deep into the Web.
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In review, three features, Helper Applications, fonts and Custom
Menus/Hotlists, are important to understand before you move on. Be
sure you

0 Have all the Helper Applications you’ll need to view graphics
and movies and to hear audio clips (see page 61).

0 Learn enough about how fonts and styles work in Mosaic to
control the look of your Web documents (see page 65).

0 Know how the Custom Menus/Hotlists feature works (see

page 68—74).

In Chapter 4, we’ll finally move beyond the confines of the Mosaic
program and into the rich fabric of the Web itself. We’ll look at how to
find your way around and how to access the various forms of hyper—
media that are floating about. We’ll also explore the many Internet
services you can access with Mosaic and how you can stay abreast of
the latest news and information about Mosaic and the Web.

Now that we have the basic technical aspects out of the way and

we’re ready to roll, let’s go for a stroll through the Web to see what
kind of trouble we can get ourselves into. Cyberspace beckons.
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All that is gold does not glitter,
All those that wander are not lost.

— ].R.R. Tolkien

Lord of the Rings

WLD WflLHIHG

Willi [BUNK

Jumping into cyberspace has always been an exciting experience for
me. Even my first login, as frustrating as it was, gave me the Net bug. I
had acquired a funky 300 baud modem and was itchin’ to see what it
could do. It came with no documentation and I really had no clue how

to install or use it. Sticking the circuit board inside my Apple IIe, I did

get it up and running—sort of. I tried logging into some local BBSes
and the newly formed (now rather famous) Whole Earth ’Lectronic
Link (the WELL) in Sausalito, California. It was like hearing a radio

message from a ship lost at sea. There was so much line noise in among
the text that I could barely make out what was going on. But I was still
fascinated. I immediately got a sense that there were all these tiny ports
of call in some vast electronic ocean. There were people "in" there...

talking to each other...having fun...exchanging information...building
something unique. After several more noisy modem sessions, I gave up
in disgust. I would have to wait for a real modem. I held out for about
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six months, until I couldn’t take it any longer. I had to get back online

to see what I was missing. I went out and bought a new computer and

a 2400 baud modem, dialed up the WELL and have hardly been off-line

a day since. That was 1987—several lifetimes in computer years.

Mosaic is not your parents’ Internet. Until recently, the language of

the Internet (and its ancestors) was rather harsh and intimidating to

learn. To navigate through the Net, you needed persistence and a head

for second guessing how machines "think." And, on top of that, every-

thing had to be communicated in plain text. It was far from what you

would call a user-friendly environment. Information services like

CompuServe, Delphi and America Online have tried to make things

easier, with login software and graphic interfaces, but they are not the

Internet. The quality of the information and virtual community they

offer is not nearly as impressive as the Net at large. Mosaic and pro-

grams like it will change all that. They are bringing the ease of an
online service to the information riches of the Internet. And, with the

addition of hypermedia and an easy-to—use document creation system,

they are moving far beyond the media desert of the "old" Internet and
into an uncharted oasis.

Web walking feels different than other types of Internet experiences.

The beehive of activity taking place there is visible regardless of how

you’re logged in, but a screenful of text, however brilliant, is very

different from a hyperlinked web of texts with accompanying multi-

media. When I log onto the UNIX-based WELL BBS, I run through a

text list of conferences, and then through topics within those confer-

ences. I come to the end of a topic, and if I want to say something, I

post a response. Then I move on to the next conference down the line.

It’s all very list-like—from top to bottom.

On the Web, there is this feeling of being potentially everywhere at

once, or at least everywhere that’s hyperlinked to the site you’re on and

everywhere that those subsequent sites are linked to, and so on. It feels
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vastly interconnective in a fashion that certainly makes “web” an apt
description. Being in the Web, with its graphical user interface and all
of its hypermedia offerings, is an immense thrill to a Net old-timer like
myself. Having been involved in hypermedia, specifically Macintosh’s
HyperCard, for many years, the Web is like a HyperCard stack that
spans the globe. It even has pop—up QuickTime movies, graphics
windows and a Home button!

But enough hyping Mosaic for a moment. Let’s stroll onto the Web
and I’ll show you a bit of what I’m talking about.

A Web Session

The first place Mosaic takes you upon launching is the home page.
Since I don’t want to add to the high volume of data traffic the NCSA

site (the default home page in Mosaic), I’ve entered my own home page
URL in the mosaic.ini file. See Figure 4-1. This page lives on my hard

drive and is not actually on the World Wide Web. Once my

home page is loaded into Mosaic, I can go anywhere on the
Web from there. The home page I’ve made has hyperlinks
to the Web sites I frequent. Later on in this chapter, I’ll

show you how to create your own home page.

Internet Connections List

From our home page, let’s check out Scott Yanoff’s Special
Internet Connections List. It’s a great source of links to a

diverse range of Internet offerings. I press Ctrl+O to pop
up the URL box and then type in the location (http:/l
info.cem.ch/hypertextlDataSources/Yanoff.html). Press—

ing the Enter key (or the OK button) starts the connection.
Once connected, Scott’s List appears in the Mosaic win-

dow. It includes lots of hyperlinks to telnet addresses,

gopher sites, finger sites and, of course, more Web sites.
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The range of topics and interests include agriculture, ham radio,

games, philosophy, aviation, careers and family issues. Since I’m in the

mood for something more recreational and for sites I can show off to

you, let’s take a hyperlink to the Internet Mall to see if it's gotten any
better since the last time I was there.

The Internet Mall

Nope. It still has a rather vacant, gloomy feeling to it, like a new real-

world mall with only a couple of stores open, and all the rest curtained

with signs that promise: Coming Soon! Everyone’s trying to pretend
that there’s excitement in the air, but it’s not heartfelt. The Grand

Opening hasn’t happened yet. The Internet Mall feels exactly like that.

It’s organized by floors: First Floor: Media, Second Floor: Personal

Items, Third Floor: Computer Hardware and Software, Fourth Floor:

Services telnet books.com. There are currently only a few items on each

"floor." Not finding much of interest here, I decide to try the link to the

Future Fantasy Bookstore.

http://www.kei.com/intemet-mall.html

Future Fantasy Bookstore
This virtual bookshop has its real-world counterpart in Palo Alto,

California. On the Web, they offer their book catalog, new book listings,

back issues of their newsletters and some fantasy art. In the new book

area, you can click on the name of the book and view its cover art or

click on the author’s name to see all the books that Future Fantasy

carries by that author. Trouble is, I don’t like fantasy. I came, attracted

to the “Future” part of their name, but I don’t see much in the way of
sci-fi titles. I do see a link to the Science Fiction Resource Guide at

Rutgers University. After goofing around for a while, looking at some

full-color scans of book covers and searching on a few authors, I jump

across the Web in search of the sci-fi guide.

http://www.commerce.digital.com/palo-alto/FutureFantasy/home.html
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Science Fiction Resource Guide

This place turns out to be the mother lode. The Guide contains a stag-
gering amount of information on science fiction literature, film, TV and
criticism. The first thing I see is a hyperlink to "A Short History of the
Internet” by my WELL buddy, sci-fi writer and cyberpundit Bruce
Sterling. (Nice essay, BTW. I hope people will read it. If you do choose
to read this, be sure to return to the Science Fiction Resource Guide to

keep up with our tour.) Scrolling through the home page of the Guide I
pass dozens of links to essays, reviews, articles, interviews, even whole
books (e.g., Sterling’s Hacker Crackdown). There are long lists of subject

: bibliographies, sci-fi film and TV show synopses, links to sci-fi critical
' journals, conventions and awards—and if that's not enough, there are

links to all the other sci-fi archives in the Web!

ftpzllgandalf.rutgers.edu/pub/sfl/sf-resource.guide.html

If I were on my own, I would probably spend the rest of the night
scrambling along these interconnected threads, reading some of the
interviews and other material available here (a FAQ for Brazil, my

favorite movie, and a three-part FAQ on the Alien films). But since I’m

trying to show off the Web to you tonight, I’ll move on. Before I leave, I
choose Add Current to Hotlist from the Navigate menu. (See “Creating

Your First Hotlist” on page 68 in Chapter 3 for more information on
hotlists.) I notice a link to the Best of the Net page (of which the Science
Fiction Resource Guide is a worthy recipient). Let’s go and see who
else was so honored.

CHAPTER 4: WEB WALKING WITH MOSAIC 87

Petitioner Microsoft Corporation, EX. 1005, p. 87



tu fl LU

ctt
d2

The rr Corve ter

dupo

Petitioner Microsoft Corporation, Ex. 1005, p. 88



do

tl IL

nd
Ft

lttp wwiirs or te Ct 1U Oil

tnternet Uiderground Music Archive

rc
tko

http/sui.s cur edulan

New Zedond Irforrrohon

IlL

Ftt ii
If cc Wa ag 11

por
ci 11

Sc erce clo Resou ce de

ci

Petitioner Microsoft Corporation, Ex. 1005, p. 89



bxing Tr2

lip
http.wwwcutdom800txla tad

UCs.suti1n.tr .vr

pa
per xtU5t-l AQ

YroxPAI Ma we

Petitioner Microsoft Corporation, Ex. 1005, p. 90



Petitioner Microsoft Corporation, Ex. 1005, p. 91

 
Figure 4-3: Heinrich Aldegrever (1502—1555?),
Intemperance.

ArtServe

This site offers both an art and architecture collection and some art

tours. You can view the databases alphabetically, with or without

thumbnail images, or you can search the databases on keywords. I
decide to browse through the print collection with the

inline images turned off. Pressing on the image I want to
see (with the right mouse button), a small thumbnail

reproduction pops up. If I then want to view the entire
image, I press on the thumbnail to begin downloading a
larger version. When the download is complete, Mosaic
opens up LView (assuming you have the LView Helper
Application on your hard drive) and begins decompress-
ing the image (see Figure 4-3). When I’m done viewing, I
quit LView and return to the art database. After some
more browsing and downloading, I decide to leave. But

again, before I do, I’ll add this site to a hotlist. I plan to
come back and take a tour of the architecture section. As a

graphic designer, this could prove to be a significant
resource for me. Because I perceive this site as a valuable
work-related resource, I add it to my "Art and Design”

hotlist instead of my general hotlist (Hotlistl). From here I
check out the Xerox PARC MapViewer and then call it a

night. Because the MapViewer is not hyperlinked on this
document, I need to return to the Best of the Net page to

take the link from there. I select the History list from the

Navigate menu, click on Best of the Net, and then click the
Load button. From the Best of the Net page, I take the

hyperlink to Xerox PARC.
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Xerox PARC MapViewer

The MapViewer proves to be very easy to use. First, to find out what

your map coordinates are, you have to take a hyperlinkto the US.

Geographic Name Server. By typing in the city and state in

Mosaic’s Search box, you find the map coordinates you

want to view. The coordinates are hyperlinked. By clicking

on them, you re taken back to the Maerewer and your Location “Arlington VA
location is plotted on the map. I typed in my hometown, mwmwncm r ‘H mm, H 5 ' Chem .I om
Arlington, Virginia. Here’s what my map looks like. See WPWW‘WWMW. Location in United States

Figure 4-4.

After about two hours online, I’m bushed. I press

Alt+F, X to quit Mosaic and then go to Chameleon to

disconnect my PPP connection. The main thing I’m excited

about from this little jaunt is the Science Fiction Resource

Guide. I plan to return there as soon as I have some free

time (after this book is finished!). The Best of the Net had

other offerings I want to check out as well. An electronic

magazine called International Teletimes edited by a sixteen- Figure 4‘43 The Xerox PARC MaPViewer-
year-old kid seemed enticing. Toto, I don’t think we’re in

Kansas anymore.

Now that we’ve had a full-blown trip through the Web and have

tried some of its hypermedia offerings, let’s take a closer look at how

these media (hyperlinks, inline images, graphics and movies) work. In

the previous chapter we looked at the features contained within the

Mosaic program. In this chapter, we’ll look at the contents of the Web

itself and how to bring its awesome resources to your desktop using
Mosaic.
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the quality is often poor. Hopefully, multimedia technology will see
some breakthroughs in the near future (QuickTime 2?) and Net-based
hypermedia will get a much needed upgrade. Lots of sites are now
using forms, user-input boxes, digital signatures, pictures with mul-
tiple hyperlinks in them and other advances in Web interactivity. Next
year's Web will be a far cry from this year’s Web. Or so we hope.

The main forms of media currently available in Mosaic are

0 Inline Images—color and black—and-white graphics that appear
as part of the Web document.

0 GIF and JPEG images—color and black-and-white graphics that
are transferred to your PC and opened up by an external view-

ing application.

0 MPEG movies—moving images in the MPEG format that are

transferred to your PC and played on an external movie player.

0 Quick'Iime movies—moving images in the QuickTime format
that are transferred to your PC and played on an external movie

player.

0 Audio—music, spoken words and sounds that are transferred
to your PC and played on an external audio player.

Inline Images
Next to text, the most common element in a Web document is the inline

image. These are graphics that can either be transferred with the rest of
the page (if Display Inline Images has been turned on), or marked by
an icon that gives the option of loading (or not loading) the image after
the page has been downloaded.

Inline images might be confusing at first because a similar icon is
used to hyperlink larger graphics, sounds, movies and even other Web
documents. The difference between an inline image and a piece of

 
Inline image icon

 

Hyperlinking icon
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hyperlinked media is that inline images all load to the screen when

Display Inline Images is selected. They are resident to the current

document. Hyperlinked media will not load automatically. You must

click on the icon to retrieve the image, movie or sound, or to go to the

page hyperlinked via the inline icon. This type of hyperlinked file is
also outlined in the anchor color (which is defaulted to blue).

On a directly connected Internet machine, you can choose to keep the

Display Inline Images option checked. This way, you’ll instantly see the
whole Web page as its creator intended it, as soon as it’s been trans-

ferred. On a SLIP/PPP-connected machine, having all the inlines

transferred when you connect to a site can be very time-consuming,

especially if you have no idea beforehand how many images are stored

on the page. For this type of connection, the best procedure is to

1. Keep Display Inline Images turned off in the Options menu.

2. When you get to a site and you’ve read through the text, click on the

inline image and hyperlink icons that interest you. Use the right button

on your mouse to view the inline image and the left button to go

directly to the linked file. Sometimes you will be given clues in the text
as to what’s behind these icons, sometimes you won’t.

Really thoughtful Web page makers will put a small caption under

the inline icon telling you what the item is and how large it is. Also,

images are sometimes repeated on the same page (or in a series of
linked pages). Since they are cached, they don’t take any extra time to
download.
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Inline image icon

 
Picture preview

fl?)
Speaker icon

There are three phases to accessing something indicated by an inline

image icon with an anchor color border around it (defaulted to blue).

Assuming you have Display Inline Images turned off and you want to

see the inline image before taking the hyperlink, you would follow

these steps:

1. Using the right mouse button, click on the inline image icon with the
anchor color line around it.

2. A small graphic or preview image is loaded.

3. If you still want to access the full file, click anywhere inside the

preview image (using the left mouse button). The larger image, movie
or sound will be transferred and displayed. If this icon is being used to

indicate a link to another Web document, by clicking on the inline

image you will be taken to the new page. In the above example, click-

ing on the preview image icon will bring you to a small image of Vice
President Gore. Click on this image and a full-screen IPEG version of

the same image will be transferred.

Note: Ifyou don’t wish to view the inline image before going to the linked

item, you don’t have to. Clicking on any hyperlinked inline image with the

left mouse button will move you directly to the hyperlinked item.

4. If the inline image icon is a link to an audio file, when you load the

inline, you will usually get some type of speaker icon. Click on this
icon with the left mouse button, and the audio file will be downloaded.

When the transfer is complete, Mosaic opens up the audio Helper

Application and immediately plays the clip.

As long as the little yellow lights and spinning planet are visible on

the Status Indicator, a download is still in progress. Sometimes things

will temporarily stop moving. The transfer is not complete until the

lights are "tumed off" on the Status Indicator and the cursor has

returned from the hourglass to the pointing finger icon.
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GIF & JPEG Images
While Mosaic has embedded within it the resources to present small

images, larger, more complex images are best handled by one of the
external viewing programs such as LView. When you click on an inline
image or a text anchor that is attached to a larger graphic, the Status
Indicator will light up and start spinning and the transfer will begin.
Once an image has been transferred, it’s stored temporarily and the
external viewer assigned by Mosaic to handle that file type is launched.
For GIF and IPEG images, LView is the default application (see Chapter 3
for full details on how to select other viewers). The viewer application

begins to process the image and displays it as soon as it’s decompressed.
After viewing the image, you can either save or manipulate the

image using LView’s many image tools, or you can quit and return to
Mosaic. Mosaic automatically reopens the viewer each time it’s needed.

QuickTime 8: MPEG Movies

If you encounter any movies online, you can transfer and Files: Size (bytes) - Date - Name (sorted)
view them if you have the appropriate players installed 50502 - 22 "or 09: 16 - y-nri-muinjgg

I - ' 906 - O: - g-m‘i— go .3
(see Chapter 3). It s a good idea to have both the Qu1ck'lime 33W: _ 3: 0:: _ E“E$1.299”
and MPEG players installed smce Web documents Will not 339523 - 22 her 09:23 - Mgfig730973 - 22 "or 09:37 - 411329.413;

873335 - 29 Her 08:14 - mgjggalways specify what type of format their movies are in
(although MPEG is the most conunon). You also want to
be careful to check out how big the files are before you

transfer them (if any clues are given). Some movies are
megabytes in size. Luckily, most Web documents do tell
you the file sizes (see Figure 4-5).

MPEGPLAY is available at most of the sites listed in this book that

offer Mosaic. QuickTime players are harder to find. The Movie Player is
available at lister.cc.ic.ac.uk in the directory /pub/wingopher/view-

ers/movies/thplay.zip. You need the current version of QuickTime
for Windows installed on your PC to use the QuickTime Player.

 
Figure 4-5: Example of how movies should be listed in
a Web document. Some lists give no indication of movie

format or size.
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Figure 4-6 shows a typical movie viewer. Your mileage may vary
depending on which viewers you're using. The one pictured here is
MPEGPLAY (MPEG).

The way MPEG handles frame-to-frame compression is

fascinating. Since most video consists of a series of objects

moving in the foreground and relative static in the back-

ground, MPEG only transmits the motion of the fore-

ground objects, rather than retransmitting both the

foreground and the background over and over again.

MPEG uses a form of pattern recognition to decide which

pixels are part of moving objects (and therefore transmit-

 
   
 

 
Ml’l (il’lAY ‘v’l .hll [Ll lli'M Mithael Simmons; r

E": Movie mum muons flap table) and which are not.

ri-l—l—‘r Audio
Figure 4-6: Movie viewer. Mosaic lets you access spoken words, music and other

forms of audio. These are transferred in the same manner

. as images and movies. Since audio of any significant

\‘Javnlmm Hulil and many Huwmzm l‘l" length can take up a lot of disk space (and take forever to

El" 5‘“ We“ 5"“19 9PM“ He'9 download), look to see if the Web page tells you how big
l—l— FF ii— the file is before you transfer it. Some Web pages will tell
"" you the size, others won’t. Figure 4-7 shows the control

window of a typical audio playback application. The

application shown here is Wham. Wham can be found at

fttp://ftp.ncsa.uiuc.edu.

 
  

’ ll W'lrrlfllllr
IIIJLllluiiJ Using Mosaic as an Internet "Front End”

One of the things that distinguishes Mosaic from other

l—l— l_ Web browsers is that it’s not only a hypermedia browsing

tool—it can also be used to access regular Internet services

Figure 4_7. Wham, a typical audio playback application such as FTP, telnet, Gopher and WAIS. You can even read
for Windows.
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That’s all there is to it. See Table 4—3 for descriptions of many of the

file types found on an FTP site and how Mosaic handles them.

Note: Clicking on thefile folder or document icon within an FTP directory

will do nothing (icons are visible). These are nonfunctional internal

images that are used to indicate the directory hierarchy and the various file

types. You must click on thefile name, not the icon, to begin the transfer.

Service Name URL Form Type of Service Notes

World Wide http://siteI/filepath] Hypermedia Use HTTP (Hypertext Transport Protocol) for
Web documents connecting to HTTP servers (Web sites).

FTP ftp://site[/filepath] File transfer Used for transferring files to your computer.

Gopher gopher://site[/filepath] Menu-driven Used for browsing and transferring files to
info. browser your computer.

Telnet telnetz//site Remote login Use to connect to another machine on the
lntemet.

News news:newsgroupname Reading You need to enter the name of your local
USENET news news server in the Preferences box to access

newsgroups.

Email (not applicable) Electronic mail To send mail while in Mosaic, use a telnet
program to log into a host that offers mail or
use a mail program like Eudora.

waisindex wais://site/ Searchable Search on keywords for text documents (mostly)
database databases that can then be transferred to your computer.

http:// Get information In Mosaic, you need to go through a
www.cs.indiana.edu/ about users hostname/usemame gateway to access the
finger/ UNIX finger command.

 
Table 4—2: Internet services and how to connect to them through Mosaic.
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Extension File Type Downloading Notes

E (none) Directory Cannot be downloaded. The folder icon is simply
used to indicate a directory on the FTP server.

.zip Compressed binary You will need the PKUNZIP utility data file to decom-
press. You may encounter other compression types
such as .ila, .arc and .hqx, although .zip is the most
common .

Plain Text \Mll be transferred to Mosaic’s document view window.

MPEG movie format Mosaic will transfer file and launch external MPEG
player.

QuickTime movie format Mosaic will transfer file and launch external
QuickTime player.

player.

.ipg JPEG image format Mosaic will transfer file and launch external JPEG
viewer.

.gif GIF image format Mosaic will transfer file and launch external GIF viewer.

.El

. Audio file format Mosaic will transfer file and launch external audio

i

(none) Unknown file format The server is unable to identify the file type.

(none) Telnet access You must have a telnet program installed and in the
proper filepath in your mosaic.ini file. (Gopher sites
only.)

(none) Searchable index Access to searchable indexes and directories.
(Gopher sites only.)

 
Table 4-3: Common file types found an FTP and Gopher sites using Mosaic.
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Notes:

1. External applications will only automatically “launch” ifyou have the
appropriate Helper Applications on your hard drive and properly mapped in
the mosaic. inifile. For thefile types above, Mosaic has defaulted thefollow-
ing applications: PKUNZIP (for compressedfiles), MPEGPLAY (for
MPEG Movies), Movie Player (for QuickTime), Wham (for audio), LView
(for GIF and [PEGfiles). See Chapter 3for instructions on how to locate
and add Helper Applications to your mosaic.inifile.

2. The icons pictured above will not appear at every FTP and Gopher site.
Some sites will not have icons at all, and you’ll have to look at the extension
(.mpg, .zip, .au, etc.) to figure out what type offile it is.

3. In the alpha releases ofMosaic, the FTP/Gopher icons are veryfinicky.
Sometimes, as you navigate through the directory hierarchy, the icons will
disappear and replaced by dots. Hopefully this will befixed infuture versions.

Gopher

The Internet Gophers (“go for”) provide information search and re-
: trieval on computer systems throughout the world. Connecting to a
‘ Gopher server using Mosaic works exactly the same as connecting to

an FTP site. You browse through a hierarchy of directories and files

until you find the file you wish to transfer. When found, you simply
choose the Load to Disk option and click on its name to begin the
transfer. You can access a Gopher site either by clicking on a hyperlink

5 that’s pointing to a Gopher or by typing a Gopher URL into the URL
box. The form would be gopher: //site/filepath (if any). Table 4-3

5 shows many of the file types you might encounter in Gopherspace.

Telnet

: Telnet is a computer terminal protocol that lets you log onto other
’ computers on the Internet. For instance, I use the telnet command to
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log onto the WELL in Sausalito, California. To do this, I log onto my
UNIX account at a local Net site and then give the telnet command to

“open well.com.” I am instantly transported to the WELL’s front door
where I can log in and go about my business. In Mosaic, there is no
ability to send email or to log into another computer :
remotely. The solution to this is to get a telnet program ' . w . .i

‘i
t In! - Copyright (c) m: by r.l.htu-. all rights reserved

and point to its location in your mosaic.ini file. It will then
work the same way as any Helper Application. If you
come to an Internet resource that requires you to log into a
remote machine to access it, the telnet address will either m is m m

be typed out or hyperlinked. If typed, you’ll need to enter 3:: 2:21:12 E2".:EL...::::::::1. mm... m.
its URL in the URL box (in the form telnet://site.domain) ' W '
and choose OK. If it’s hyperlinked, all you do is click on
the link. If you have a telnet program installed on your
machine (and linked via the mosaic.ini file), Mosaic auto-
matically launches it and makes the connection. That’s all
there is to it. If you’re using the Chameleon Sampler disk Figure 4-3; A remote 108m from Mosaic using the
or Trumpet Winsock, you already have a suitable telnet Trumpet Winsock telnet program.
program. The Trumpet Winsock applications (which
include a telnet program) can be FTPed from ftp.ncsa.uiuc.edu in the
directory PC/Mosaic/sockets or from ftp.utas.edu.au in the directory
/pc/ trumpet/Winsock. Make sure you download the winappszip file.
See Figure 4-8.

 
Qfll llP _._._._.._._._._._._._._._

Don’t forget that you can use the Windows Notepad to cut and
paste URLs you find while in Mosaic or while using other Internet
services. That way, by saving them electronically and not writing
them down, you remove the risk of copying them incorrectly.
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the messages, just click on the title and the full article will be displayed.
There is always a hyper-linked item at the top of the window called
Earlier Articles. By clicking on this, you can access the previous 20
postings. See Figure 4-9.

WAIS * ‘

WAIS (pronounced “ways”) is a text search and retrieval 1" if "k ' N 7 “2 ‘ 7
system similar to FTP and Gopher. An acronym for Wide—
Area Information Server, WAIS gives you the ability to

search databases of mostly text-based documents by using

keyword queries. Similar to Gopher, you don’t have to
know anything about what type of database is being
accessed or where it’s located. WAIS deals with all this for

you. Unlike Gopher, you can’t browse the databases; you
can only keep trying keyword combinations and hope for
a match. WAIS databases cover everything from agricul-

ture to social sciences. The easiest way to plug into the WAIS

system is to go to httpfinfoxemch/hypertextll’roducts/
WAIS/Sources/Overviewhtml. There you’ll find a master
index of WAIS databases.

 
Figure 4-9: A USENET newsgroup in Mosaic.

Finger
Finger is a utility that lets you look up information about users on
UNIX systems. Most of the time a user’s Finger file consists of their
login name, their real name, the last time they accessed their account
and if they have any unread mail. There is also an area in the Finger file
to show a "plan," which can be a bio or anything else the user wants
other people to see. Many UNIX system administrators don’t make the
Finger files available over the Internet without the express permission
of the users of their system. Some people use Finger files as a way of
broadcasting information to the Net. There are Finger files with base-
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ball scores, quotes of the day, California earthquake information and
other news and trivia. These public information Finger files are traded

over the Net like other cool sites, newsgroups and mailing
lists. Some Net artists put ASCII-based art into their files.

in 1: I: U. ' s: F F A . In Mosaic for Windows, you can access Finger files by

. m w. v n m ,, mm H.
Elle Eon Mon: um Surfing Palm. Help

  W’Mf , . . ,7 __ going through a gateway that accesses Finger. The gate-
The W to Finger Gateway I" way address is http://cs.indiana.edu/finger/gateway. This
m “99°” I“ site is already offered as a menu choice (Finger Gateway)
I under Starting Points. At the gateway site you can read

“"8 more information about Finger files and the WWW gate-
Izmmzmmtmm;fiEZZWWM” T'" “‘"" - -
wmnm,mmmammmummmm“0me way to them. You can also search on a Fmger file from
"'“”’"m”'““”'”"‘““"‘“°"”°“"’ anywhere within the Web by using the URL http:/I
mmggmmgmmm “" M" "W"Wm" www.cs.indiana.edu/finger/hostname/usemame. For
how m-';a;;;n;nnv°-mmm;mfwhbumwmwm' instance, to view a Finger file of late—breaking NASA
nmmwmmmmmmm "mmmwsmmdonmh-wc 2 news, type http:l/www.cs.indiana.edulfinger/

—Vfill; space.mit.edu/nasanews. See Figure 4—10.
Figure 4-10: The Finger Gateway.

HTML ASAP: Making Your Own Web Documents
Making your own Web documents isn’t rocket science—in fact, it isn’t
hard at all. If you can use a word processor and are familiar with fonts
and style changes (bold, italic, underline), you can create HTML docu-

ments. HyperText Markup Language is simply a method for marking
text in such a way that it looks and behaves the way you want it to
when it’s viewed in a Web browser. The marking codes may look
arcane at first, but once you get the hang of them, you’ll be confident in
moving on to more sophisticated document construction. Let’s get
started by making a simple home page. All you’ll need is a text editor
and a little patience.
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Begin Code

<T|TLE>

<H I >

<|MG SRC="”>

<A HREF=””>

<P>

<BR>

<B>

<|>

<U>

<A NAME=””>

<OL>

<UL>

show your text, and that these codes are containers that can be nested,

you’re now ready to dig deeper—constructing your own home page,
complete with images and hyperlinks.

The HTML Style Tags
The foundation of any HTML document is its many formatting codes,
or “tags.” Table 4-4 lists the basic tags and what part of an HTML
document they affect.

End Code

</TITLE>

</Hl >

Not applicable
</A>

Not applicable

Not applicable
</B>

</l>

</U>

</A>

</OL>

</UL>

 
Table 4-4: Basic HTMLformatting tags.

Title

Headers
What your document is called on the Web.

Headings differentiate between parts of
your document.

This causes an inline image to be displayed.
A way of pointing at a different Web
document, a media clip, etc.
A paragraph of text. Unlike the other
formatting commands, you only have to
put the <P> tag at the beginning of the
paragraph.
Same as a hard retum.

Shows text in boldface type.
Shows text in italic type.
Underlines a word or phrase.
Links to other parts of the same document.
Causes a list of items to appear with
identifying numbers next to each element.
Causes lists to appear with bullets,
asterisks or + signs next to each list item,
depending on the browser.

Image
Link

Paragraph

Line break

Bold

Italic

Underline

Internal Link

Ordered (numbered) List

Unordered (bullet) List
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Building Your Home Page
Your most basic home page would consist of a title, a
header or two and some text. At this point, we won’t

worry about links, images and sounds. To begin,

1. Open a new document in your favorite text editor or
word processing program.

2. Decide on a title for your home page. "My Home Page”
is probably as good a place to start as any. Since the title of
your page should appear as the first line in your HTML
document, type <TITLE> to indicate you are about to
enter the title of your page.

3. Next, type in the name of your home page and then
<II'ITLE> to indicate the end of the title. Your document

should look like this:

<TITLE>My Home Page</TITLE>

4. Let’s put a header at the top of the page. There are six
levels of header tags in HTML, with each level down a
slightly smaller typeface. Since this is your top header, and
you want to make it big, you should use Header level 1.

5. Type <H1> to indicate the beginning of your header and
then type the actual header. Something like "Welcome to
My Home Page.” Finally, type <IH1> to indicate the end of
the header. So far, your home page HTML document
should look like this:

<TITLE>My Horne Page</TITLE>
<H1>Welcome to My Home Page</H1>

 
6. Now, add some text or a blurb about yourself. Since this information

might be several lines long, you’ll want to use the paragraph HTML
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tag so that it formats correctly. Type a <P> tag, hit enter to get to the

next line and type some stuff about your home page, like this:
<P>

This is my first home page. It will be my jumping off point into the rest

of the Web. Hello cyberspace!

Note: Remember, Mosaic doesn’t care how many blank lines you use, or

how many spaces you indent your paragraph, or where you put the line

breaks. Mosaic is only concerned with the way the document is tagged. So,

ifyou do want the lines to break at a specific point, such as in a poem, you

need to put a <BR> code at the end of the line where the break should occur.

This is like hitting a hard return at the end of each line in a word processor.

Ifyou do this, no matter how big or small the Mosaic window is, it will go
to the next line when it encounters the <BR> code.

At this point, your home page HTML document should look like this:

<TITLE>My Home Page< /T1TLE>

<H1>Welcome to My Home Page</H1>
<P>

This is my first home page. It will be my jumping off point into the rest

of the Web. Hello cyberspace!

You have now constructed a working home page! A little dull

maybe, but it is an HTML document and will function quite nicely as a

home page until you want to get more elaborate. Let's go look at it in
Mosaic.

7. Save your document as a text file in the Mosaic folder. Call it what-

ever you like (e.g., ”home.htm”), but make sure it ends in .htm.

Note: On the World Wide Web, HTML documents end with the extension

.html. On the PC, since extensions can only be 3 characters, all HTML

documents stored on your hard drive need to end in .htm to be readable on

your PC.
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8. Launch Mosaic and select Open Local File from the File menu. From

the Open dialog box, find your text file and click the OK button. Your

home page should now load and be visible within the Mosaic docu-
ment View window. How does it look?

9. To make this your permanent home page, change the Home Page:

line in your mosaic.ini file by typing the file path and name of your
HTML document. Also make sure that Autoload Home Page is set to

yes. You’ve done it! Now when Mosaic starts up, you’ll go directly to

this home page on your local hard drive rather than having to wait to

connect to NCSA. If you want to go to NCSA once you’re in Mosaic, you

can still get there by choosing its name from the Starting Points menu.

Adding Some Pizzazz

Face it, a home page like this is pretty boring. If you’ve been doing any

Web walking, you know that the WWW is just bursting at the seams

with graphics, sounds and hyperlinks. In fact, if you came upon a

home page like the one you’ve just constructed, you’d probably keep

right on walkin’. The great thing about HTML is that adding all the

media files is as easy as formatting them!

To add a link to a picture on your hard drive,

1. Find a suitable picture. If you have a scanner, you can scan some-

thing in—a picture of yourself, for instance. Or, how about a piece of

computer art? It doesn’t matter what it is, as long as it’s in GIF format

(and not too huge).

2. Put the picture in the same subdirectory as your home page and
name it <name.gif>, with "name" being whatever you choose.

3. Open your home page HTML document in your text editor. To insert

a link to your picture, enter a special tag that tells Mosaic where to look

for the picture when it opens your home page. Type <IMG SRC=

"name.gif”>
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You need to type this in the place in your document where you want

: the picture to appear. For example, if you want the picture to appear

below the first header in your home page, you would add the line like
' this:

<TITLE>My Home Page</TITLE>

<H1>Welcome to my Home Page</H1>

<IMG SRC=”name.gif”>

: <P>

This is my first home page. It will be my jumping off point into the rest
' of the Web. Hello cyberspace!

: 4. Save your HTML document (as a text file!) and open up Mosaic.
Choose Open Local File from the File menu.

If you look at the Status Indicator as your home page is being

opened, you’ll see that the icon lights up and starts spinning. That’s

your multimedia home page being loaded!

If you have the Display Inline Images option checked, your picture

will appear when your page does. If you have this option turned off,

you’ll see an inline image icon where your picture is "stored." If for

some reason your image doesn’t load (if it's not a GIF or you didn’t

type the name in correctly) you’ll get an Error Accessing message.

Now that you have a picture on the page, how about adding some
sounds?

1. First, record your sound with SoundBlaster or some other PC record—

ing application and save it as an .au sound file in the same directory as

your home page. Say you record a greeting—you could call it
"greetingau".

Since Mosaic won’t auto-load sounds as it does images, you'll have

to put in a link anchor to your sound. A link can be anything: a word, a

sentence or an inline image. In this case, we’ll use a word as our link.
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2. Construct the link to your sound by typing the tag into the place

where you want the link to appear on y0ur home page. For example,

<A HREF=

This tag tells Mosaic you want to link to whatever comes after the = .

3. Next, type the name of yOur file in quotes.

<A HREF=”greeting.au”

4. To make a link show up in your home page, you need to type in the

description of what you are linking to. First, type >, the beginning of

the container for the link's name. Next, type in the name of the link as

you want it to appear on your home page. In this case, let’s use “Click

here for greeting." Your line should now look like this:

<A HREF="greeting.au”>Click here for greeting

5. To end the line, type </A> to mark the end of your tag. Your final

sound link tag looks like this:

<A HREF:"greeting.au”>Click here for greeting!</A>

6. Save your home page HTML document, open Mosaic and watch

your home page load. You should see your new greeting link appear.
Click on it to hear the audio.

links to the Outside World

You now have a snazzy little multimedia home page! But something

important is still missing. You have no way of getting onto the Web.

You need to add some hyperlinks so you can easily take off from this

home page to global ports of call.

The basic format of any link is the familiar URL. If you were asleep

during the URL discussion in Chapter 3, you should go back there now

and brush up on what a URL is and how it works.

I I4 QUICK TOUR
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Before you add any links to your home page, you’ll want to add a

new header to indicate that this is a hyperlinks section of the document.

1. Open your home page in your text editor. Go to the end of the
document. Since this header is below the first header in terms of the

layout priority of the document, you’ll want to use a Header level 2

this time. Type something like

<H2>Links to the Outside World</H2>

2. Now you can add a few handy links. A good one is the NCSA

What’s New Page. By checking this page frequently, you can keep track
of all the latest Web happenings and announcements.

3. To construct a link to this page, you’ll use a format similar to the one

we used to link sound. The sound link was to a file on your own

machine. Since here you want to connect to a file (the NCSA What’s

New Page) on another server, a URL is needed to make the connection.

Below your second header, type <A HREF=”HTTP://
www.ncsa.uiuc.edu/SDGISoftware/MosaidDocs/whats-new.html”

This line tells Mosaic to go to the NCSA WWW server

(www.mcsa.uiuc.edu), skip to the /SDG/Software/Mosaic/Docs/

directory and grab the file ”whats-new.html."

4. Just like the sound file, you need to have some way of indicating on

the home page that there’s a link. Add a link description similar to the

one for sound. Type >What’s New on the Web<lA> at the end of the
URL line. The whole line should now look like this:

<A HREF=”H'ITP: //www.mcsa.uiuc.edu/SDG/Software/Mosaic/

Docs/whats-new.html">What’s New on the Web</A>

When this line loads into Mosaic, you'll see "What’s New on the
We ” underlined.
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5. How about adding another link? Sometimes you want to search for
something on the Web but have no idea where to find it. Something
called a Web search engine keeps an index of all the contents of the
WW and lets you search on it by keywords. When it finds a match,
you get a list of those matched items, presented as hyperlinks. These
search engines are like robot librarians with a collection that spans the
globe. An excellent and highly recommended search engine is called
the WebCrawler. To add a link to it, go to the next line in your docu-

ment and type <A HREF:”H'I'I‘P://www.biotech.washington.edul
WebCrawlerfWebQuery.html">WebCrawler Search<lA>

When this appears in your Mosiac document, all you’ll have to do is
click on the words "WebCrawler Search” and you’ll be instantly trans-

ported to the WebCrawler’s home at the University of Washington.

Now that you’ve got two links in a row, you’ve got a list! Well, at
least you think it’s a list. Mosaic still thinks that it’s two links right next
to each other. Remember, Mosaic doesn’t know diddly about text

formatting! To put the two links into list form for Mosaic, you have to
attach HTML tags.

There are two major types of lists: numbered and unnumbered.
Numbered lists have numbers appearing at the beginning of each

unique list item. Unnumbered lists have a bullet in front of each item.
They both work the same way, so it’s up to you which one to use.
Here’s how to add a list-format container:

1. Go to a point just above the first item (NCSA What’s New Page) and
hit Enter to insert a blank line. If you want your list to be numbered,

type <OL> for "ordered list.” If you want an unnumbered list, type <UL>.

2. Next to each link, type <LI> to indicate that the link is a list item.

3. Close the container by going to the line right beneath the last link

and typing </OL> if you have a numbered list and </UL> if you have
an unnumbered list.

1 16 QUICK TOUR

Petitioner Microsoft Corporation, EX. 1005 , p. 116



Petitioner Microsoft Corporation, Ex. 1005, p. 117

4. Save your document, open it up in Mosaic and gloat—you have now

constructed a full-featured home page!

You can add as many links as you like by either adding them as

we’ve outlined above, or by cutting and pasting them from other
HTML documents.

Your First HTML Document

Your home page HTML document should look like this (see Figure 4-11):

<TITLE>My Home Page</TITLE>

<H1>Welcome to my Home Page</H1>

. <[MG SRC=”name,gif”>
Welcome to my Home Page

Imam
<A HREF="greeting.au">Click here for greeting!</A>
<P>

1““ “WWW?” "M" “WWW“9°” "‘°"‘"‘“°”’° w“ This is my first home page. It will be my jumping off pointHellocybcnpue!
ljbtomeOIuideV/ofld

0W
0W  

Figure AM]: My Home Page.

into the rest of the Web. Hello cyberspace!
<H2>Links to the Outside World</H2>

<UL>

<LI><A HREF=”HTTP: //www.mcsa.uiuc.edu/SDG/

Software/Mosaic/Docs/whats-new.html”>What’s New

on the Web</A>

<LI><A HREF=”HTTP: //www.biotech.washington.edu/

WebCrawler/WebQuery.html">WebCrawler Search</A>
</UL>

Now that you’ve gotten your first taste of HTML document making,

you may want to delve deeper into how it's done. Why not use this as
an opportunity to ask your robot librarian for some advice. Go to the
WebCrawler and do a search on “HTML” (or maybe more specific

things like "HTML Primer" or "HTML Style Guide”).

CHAPTER 4: WEB WALKING WITH MOSAIC 'I 'I7
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field, don’t clutter it with trash. Try to keep the number of

stylistic elements to a minimum and work the flow of the
document so that it has as much impact as possible. An old

graphic arts trick is to squint when you’re looking at a page of

design. By fuzzing your vision a bit, you can see the elements of

a page as interacting objects rather than their specific content.
Do this on your documents until the elements are balanced (or

unbalanced in a pleasing way).

Keep in mind that different types of browsers will be used to
view your documents. While lots of graphics and jazzy color
elements might look great on your browser, someone using a

text-based browser (such as Lynx) might just see a confused
mess.

White space can be a good thing. Learn how and when to use it
to your advantage. Set things off for emphasis by surrounding
them with white space.

Try to "chunk" information into logical units. Use common
sense and an eye toward logical organization when you’re

laying out your documents. It is best to let the material unfold
in levels, rather than having everything appear at once.

Integrate your links into the material. Don’t put "Click here!”
off by itself with no point of reference. Your links should go
where they make the most sense, ideally in context. If you do
put them off by themselves, say what they are: "More informa-
tion on widgets."

Check your links! It’s a nuisance to find a document that has

links that don’t go anywhere. Before you post your documents,

make sure that everything works.

CHAPTER 4: WEB WALKING WITH MOSAIC I I9
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0 Be literate. Again, this is as much a publishing environment as

anything else. Use a spell checker and read over everything
before you post it. One writer's tip: Read out loud what you’ve

written. If it sounds good spoken, chances are it will read well

on the page.

0 Sign all of your documents. People like to know who wrote Web
documents, and ideally, how to contact them. Don’t just sign the

"front" page of a document series. Sometimes people will come
in the back or side doors to your documents (if they have a URL

to a page that’s not the first). If you don’t label these secondary

pages, no one will know whose handiwork they are.

0 Give as much information as possible about the size and con-

tent of inline images and hyperlinked media. You can label

inline images with a caption (57k image) or hyperlinked media
with a written description: “1.2mb performance video in MPEG
format." If a media item is really huge, it should have an even

more emphatic message: "CAUTION: This QuickTime movie is
2.7mb in size!” (Remember, people don’t read instructions. You
have to shout sometimes.)

0 Limit your use of inline images. Try to find small, high—impact

images, and overall, use images sparingly. Think in terms of the
different types of users who will be accessing your pages. Some

may have fancy Silicon Graphics workstations connected to T5
lines, but others will be putting along at 14,400 baud. Try to

create pages that will communicate and satisfy at all levels. It’s
a challenge, but it can be done.

0 Don’t be afraid to break any of these rules if you’ve got a good

reason for doing so.
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Information Sites

Mosaic Information Site

A great starting point for seeking any type of Net/Web-

related information and help. Lots of links fan out from
here.

http://www.ncsa.uiuc.edu/SDG/Software/Mosaic/
Metalndex.html

WWW Information Site

The WWW Information Site graciously provides a link

breakdown of WWW-related information. Users, develop-

ers, service providers and Web page authors will all find

plenty of interest here. And, because it’s all hyperlinked,

each of the links connects to even more interesting Net

points. A good place to start if you have a specific subject

area you want to explore.

http://www.bsdi.com/sever/doc/wes-info

Newsgroups

HEWSJIIISWGI'S

The repository for FAQ files from across the Internet. A

huge body of information is accessible here. Before you

ask, get the FAQs! All FAQ files that are posted to this

newsgroup are archived at ftp://rtfm.mit.edu/ or ftp://

ftp.uu.net/usenet/news.answers/

They are also available in HTML format at

http://www.cis.ohio-state.edu/hypertext/faq/usenet/FAQ-
List.html

I22 M3§AIC QUICK TOUR
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Tales From Hyperspace Members of the
academic community have been keenly
interested in hypertext since thel 9605. Within
the realm of r ressive literature, it’s seen as

a writing tec no ogy ideal suited for com-
municating the fragmen and multifaceted
nature of postmodern life. So far, most of the
experiments in “hyperlit” have been done by
individual authors, in rCard or other

hypertext programs, on distributed on disk
as electronic books. John Schull and Charles

Deemer have a different idea. They want to
grow the world’s first collaborative Web novel.
Called Stories from Downtown Anywhere, this
hypertext work will incorporate many voices
and many levels of talent. Anyone on the Net
is free to submit work for consideration by the
book's editors. Interlocking smaller stories are
hyperlinked to create a larger fictional
universe. If you read a story thread and see
something you want to develop, a character, a
physical space or anything else that strikes
your fancy, you email your suggestions to the
project’s editors for approval. Once your
contributions have been accepted, they are

hypeiiinked into the story. novel is also ->
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comp.infosystems.announce

This newsgroup for the announcement of new information systems has
also become the de facto place to announce new Web

interactive, with a, has, Mo choices in pages and sites. The University of Rochester has created a

narrative direction mflable within each Web document announcing all the new pages announce-
sto fragment. ments posted to this group. You can access the Rochester

e URL for the project is http:// document at http://www.cs.rochester.edu/users/grads/
www.cmmcom/stories/ ferguson/announce/

From here, you can link to all the existing It’s a good idea to add this address to one of your hotlists.
ports of the story (so for there are only a few) ,
or find out information on how to contribute comp-'“fOSYSEms-www-"sers
your own tales. For discussions of browsing software, new user questions

Halli-IIIIIIHIIIIII-n and general news, information and assistance.

comp.infosystems.www.providers

If you’re interesting in setting up and administering a WWW server,
this is the place to find out more about it.

comp.infosystems.www.misc

This group is set up to discuss everything not covered in the other

WWW newsgroups. The future of the Web, protocols and standards
have been recent topics of discussion.

comp.infosystems.www (defunct)

comp.infosystems.www was the original group created for discussing
WWW. It has now been subdivided into the groups listed above. Many
sites that carry USENET News still include it, but it will soon dissolve

in favor of the other comp.infosytems.www.* groups.
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Moving On
Hopefully you’ve now had enough time online to understand how the

Web works and what Mosaic has to offer. If you haven’t tried all of its

features, take some time to go back through this chapter, focusing

especially on browsing the Best of the Net award—winning sites and

trying out the various Internet services that Mosaic can access. Doing

this will put both you and Mosaic through your paces and in Mosaic’s

case, make sure that it’s properly configured and that all the Helper

Applications are installed.

Chapter 5 is a directory of Web sites, covering everything from

online libraries and art galleries to electronic magazines and recreation

centers. This is not a exhaustive catalog, but thanks to the beauty of

hypermedia, all these sites are connected to dozens more, which are

connected to still more, and so on and so on. There are enough access

points here to take you deep into the fabric of the Web, enough connec-

tions to keep you busy for years. 50 pack a lunch, lace up your power

walking shoes and scamper onto the first available Web link that

strikes your fancy.
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